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A Quick Tour of F9 
This is a short tutorial designed to familiarize you with the basic concepts of creating financial reports with 
F9. Every F9 financial report starts as a spreadsheet and uses the features of either Microsoft Excel 2007 
or Excel 2010 and F9 Version 5.  
 
For this reason you will also find Excel's online Help to be an invaluable aid when you create your 
financial reports. To find complete information about any F9 feature, refer to F9’s on-line Help for more 
details. 
 
Where there are differences between Excel 2007 and 2010, separate instructions and screenshots will be 
listed. 
 
 
 
 
 
 
 
 
 
 

Getting Started 

1. Open Excel and ensure F9 is attached. 

There should be an F9 tab to select within the Excel Ribbon:  

Excel 2010: 

 
 
Excel 2007: 

 
If the F9 Ribbon is not present, please refer to Installation and Setup instructions installed in the F9 
folder called: F9 Readme for (your product).PDF. 
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2. Ensure that you have a blank workbook open.  
 
Excel 2010: 

• To open a blank workbook, choose the File Tab , New, Blank Workbook, and 
Create. 

 
 
 

Excel 2007: 

• To open a blank workbook, choose the Office Button , New Workbook, Blank 
Workbook, and Create. 
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3. Ensure Calculation in Excel is set to Manual. 

This allows users the most control on when F9 results will be refreshed.  

Excel 2010: 

• Select the File Tab , Options, Formulas and click Manual as shown: 

 

 

Excel 2007: 

• Select the Office Button , Excel Options, Formulas and click Manual as shown: 

 
   
 

 
 

With Manual Calculation, you can calculate an entire workbook (or all open workbooks) by pressing 
the F9 key. Shift+F9 is used to calculate the active visible worksheet and F2+Enter calculates just 
the active cell. To save you time, all F9 reports should be created with Excel set to Manual 
Calculation so that the entire workbook does not recalculate every time you edit a cell. 
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4. Next, ensure F9 is Setup to access the Demo company data with name Fabrikam Ltd and ID -1 and 

continue with this quick tour.  
 

• Select from the F9 Ribbon F9 Setup.  
 

• If you do not see Fabrikam in the Company dropdown, select Change Server and select 
server where your accounting data is installed.  

 
 

For more information on the data F9 accesses for your accounting system, refer to the Information 

section within F9’s Help by selecting F9 Help from the F9 Ribbon:  
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Quick Trial Balance 

1. F9 can quickly output your Chart of Accounts and period values in a variety of ways. To begin, 
select from the F9 Ribbon, F9 Table. A F9 task pane will display to the right of the active 
worksheet. Hover the mouse on the task pane’s left border to drag the display to the left or select 
the dropdown control at the top of the task pane and Size to control the display and docking. 

  

2. Within the tab: F9 Table, set the F9 dropdowns to output the entire Chart of Accounts by typing 
an * in each account part;  select Company -1 , BUDGET1, 2004 and Month 1: 

 

3. Next select tab: Options.  

• F9 Chart: select Include Account Code, Description and Account Origin  
• Output: select F9 Classic Chart, Values, New Sheet  
• Formatting: select Add Total Row 

4. Click on the Find button at the bottom of the F9 Table task pane to see the results output in a 
new worksheet. The columns will be sized to display your information and should like similar to 
the following: 
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5. As a trial balance, we should ensure the total for the period totals zero. We set F9 Table to create 
the subtotal formula within the Options tab and we can scroll to the end of the report or a faster 
technique is to use the keyboard End key:  

a. Click on any cell in column E with a value. 
b. Click the End keyboard key and then the down arrow key. 
c. Excel should bring you to the end of the report in column E. 

The last cell should contain an Excel =SUM(…) formula similar to:   and its value 

as:   

6. To improve the format of this cell, select the Excel Home tab and within the group Number the 
comma option: 

  

The value in the trial balance total should now display as:   To return to the top of 
the report, click at the same time: Ctrl + Home from the keyboard. 

7. Notice the current report contains accounts with zero amounts. One way to not display these 
rows is to use the F9 Zero Suppress command. First, select the range of information to suppress 
– one way is to highlight the entire column E. Click the F9 Ribbon tab and within group F9 
Tools, select Zero Suppress and then Zero Suppress Rows from the dropdown. 
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The F9 report should now display just rows with amounts. Notice the rows with zeros have been 
hidden in Excel. To redisplay the rows at any time, simply highlight the area and select Undo 
Zero Suppress. 

8. Rename the worksheet containing the F9 trial balance report to: Trial Balance 1.  

9. Save the workbook as F9 Tour.xlsx by selecting the Excel 2010 File Tab  (or Excel 

2007 button ), Save As, Excel Workbook. 
  
Notice the default extension in Excel is now .xlsx; this means the file is stored in XML format 
which will be approximately 60 per cent smaller in size from the same report saved as an .xls file, 
which is Excel’s previous binary output.  
 
There are many other benefits to saving Excel files to the new XML format such as improved 
stability of files with less chance of corruption issues;  in addition, Excel’s XML can be extended 
by other applications programmatically and is the industry standard for web-based 
communications. 

 

A More Dynamic Trial Balance  

In the first example, F9 Table output the most basic report with just values in the rows and one subtotal at 
the end. Next, we will generate the same report with dynamic report controls and F9 formulas to return 
descriptions and values across all account rows. 

1. First, we will ensure F9 is setup to create report dropdown controls. From the F9 tab, group 

Options, select F9 Add-in Options . Ensure Create F9 Report Controls is 
selected and hit OK. We will see how this works with a new report created by F9 Table. 

 

2. Back to the F9 Table task pane, we will make just one change within the Options tab: 
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a. Output: select F9 Classic Chart, GL Formulas, New Sheet  
3. Click on the Find button at the bottom of the F9 Table task pane to see the results output in a 

new worksheet.  

              
 
 
 

4. There are two differences in this report. First, F9 report dropdown controls are created for easy 
selection.  

a. Change the year to 2005 and click Shift-F9 to recalculate the trial balance; values for all 
account rows update automatically. How this is done is with F9 formulas that are based 
on a number of different filters and parameters. 

b. Change the period in column E to Month 2 and recalculate again. F9 recognizes 
accounting like phrases to retrieve period balances. 

 
The second and most significant change is that F9 formulas have been written to control the 
results returned for all rows with accounts. This makes the report dynamic; change a reporting 
filter such as Type and values change with recalculation; post transactions to the GL and 
recalculate an F9 report to see new values automatically. No recreation of your report required. 

a) Edit the account specifier in cell B11; change it from: 000-1101-00 to: *-11*-*. Click Shift-
F9 to see the new period total for the account grouping. This is one example of how to 
combine multiple criteria within F9 formulas.  

b) Delete the rows of accounts we just combined. Highlight the 3 entire rows below the new 
account and right-click to Delete. Your trial balance total should once again be zero as 
expected.  

c) Save this worksheet tab as: Trial Balance 2 and save your entire workbook also. 
 
 
 
Now that we have created a more dynamic Trial Balance report that can recalculate with different results 
when a report filter such as the Period changes, we will want to start learning the how F9 formulas work 
to create flexible reports of any nature. 
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The Fundamental F9 Formula 

The GL Function is the fundamental F9 formula as it links any cell in your spreadsheet to any balance in 
your general ledger. This is accomplished with a set of parameters that tell F9 what balance you would 
like returned. The syntax of the GL formula is: 
  
=GL(Account, Period, Company, Year, Type, Currency) 
Where:  

Account is the GL account(s) specifier 
Period   is the fiscal period(s) 
Company   is one or more company specifiers 
Year  is the specific fiscal year 
Type  is the actual or budget type 
Currency   is the currency type (if supported in your accounting system) 

 
Write this formula down; in fact write it down twice, as it is the core of all F9 Reports. 
The GL formula does not require all 6 parameters, so if your accounting system does not support 
currencies, you do not need to enter this specifier. 
  
In many instances you will want your balances to be returned as negative values. To do this, simply use 
the =NGL( … ) function in place of the GL function. The parameters of the NGL function are identical to 
the GL function. 
 

The GL Formula 

1. Open the F9 Tour workbook, and select the Trial Balance 1 worksheet tab.  
2. Unhide the zero suppressed rows to work with all accounts. Select the entire worksheet by 

clicking on the upper left corner: 

  
 

Next, from the F9 tab, select Zero Suppress and Undo Zero Suppress.  
3. Cell E10 should contain your first period amount. Click on cell E10 and you will see that although 

there is a value in this cell, there is no formula. The true strength of F9 is rooted in F9 formulas 
and the ability of all spreadsheets to use absolute and relative cell references so that they can 
turn on a single cell. 

4. In cell E10 type the GL formula, substituting the appropriate cell reference for each parameter of 
the GL formula. In the example below, as in your sheet, the GL Formula will be: 

=GL(B10,E8,B2,B3,B4,B5) 
Where:  
B10  is the Account number 
E9  is the Period 
B2  is the Company 
B3  is the Year 
B4  is the Type 
B5  is the Currency 
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ENSURE THAT YOUR CELL REFERENCES ARE CORRECT and press F2+Enter to calculate the cell. If 
the formula is correct, the cell will return the same value, but it will now be based on an F9 formula. 

As you will notice, none of the other values below cell E10 have changed. This is because they are not 
formula based. Don't worry, though; you do not have to type the GL formula again if you use the correct 
Absolute and Relative cell references and Auto-Fill. 
 

Absolute and Relative Cell Referencing 

By default, a formula you create in Excel uses Relative cell references. This means that if you copy a 
formula, Excel will automatically adjust the cell references in the copied formula to refer to different cells, 
relative to the position of the original formula. So, if we copy this formula from cell E10 to cell E11, all row 
references will change by one row. This formula would then be: =GL(B11,E10,B3,B4,B5,B6). 
  
In the new formula, the Account specifier (B11) is correct, but the Period specifier is now cell (E10), which 
is obviously not correct. In fact, the Company (B3), and Year (B4) are also incorrect now. To copy this 
formula correctly, we will have to ensure that Excel does not adjust the cell references when we copy the 
formula. This is called an Absolute reference and is accomplished by placing a dollar sign ($) before the 
parts of the reference that should not change. 
  

1. Click on cell E10, and in the formula bar (located at the top of the spreadsheet, above the column 
names) move your cursor to the beginning of the Account reference (B10). 

        

2. Press F4. Each time you press F4, Excel toggles through the combinations: absolute column and 
absolute row ($B$10), relative column and absolute row (B$10), absolute column and relative row 
($B10), and relative column and relative row (B10). We will want the Account reference to change 
as we copy down rows (relative, no $), but not across columns (absolute, $). Press F4 until the 
Account reference is $B10. You can also add the $ symbol with the keyboard. 

 
3. We will not want the Period reference to change as we copy it down rows, but we will across 

columns (relative column and absolute row). Make the Period reference E$9. 
 

4. The Company, Year, Type and Currency cell references should not change when we copy the 
formula down or across the report, so make both the column and row references absolute as:  
$B$2, $B$3, $B$4, and $B$5. 

 
5. Press Enter to complete formula edit. 
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The formula should now be: =GL($B10,E$9,$B$2,$B$3,$B$4,$B$5) and is ready to be copied down all 
of the account numbers. 

Auto-Fill 

1. Before we copy the new F9 formula to all the rows below, go to the last row and insert a blank 
row between the Total and the last account. We will see why this is required once the Excel Auto-
Fill completes. Select Ctrl-Home to return to the top of the report. 

2. Click on the cell with our first GL formula, (E10). You will see a fill handle which is located at the 
bottom right of the cell when it is selected. Move your mouse over the fill handle, and your pointer 
will become a crosshair. 

 

3. Double click the fill handle. The formula will now copy down all rows that have an adjacent value 
in Column D. If there is no value in Column D, or if your version of Excel does not support this 
feature, simply drag the formula down by clicking and holding the left mouse button over the fill 
handle and dragging the formula until the last row with an account number is selected. 

4. Click on any cell in your spreadsheet. You will notice that all of the cells have the same value as 
cell E10. This is because the sheet is set for manual calculation. Press F9 to calculate the 
workbook, and the values from your GL will populate the report. 

 

Description Formulas 

We will now want to make the descriptions in this report formula-based so that when you edit an account 
number it will return the appropriate description. 
  
In F9 there are two formulas for returning account descriptions, these are the =DESC Function and 
=SDESC Function. DESC returns the account description for the full account code. If the DESC function 
is used on a range or list of accounts, it returns the description for the first account found in the range or 
list. SDESC produces the descriptions associated with the individual segments of the account code. In 
short, the DESC is used to return the Natural Account description and SDESC is used to return the Sub-
Account description. 

The DESC Function 

The syntax of this formula is the similar to the GL function with less specifiers: 
 
=DESC(Account, Company) 
Where:  

Account is the GL account(s) specifier 
Company   is the specific company 
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The SDESC Function 

The syntax of this formula is: 
 
=SDESC(Segment, Segment Number, Company) 
Where:  

Segment  is the GL segment specifier 
Segment No  is the segment position 
Company    is the specific company 

 
Segment Number always contains the number of the segment you wish a description for. The first 
segment is "1." 
 
Make the descriptions in this report formula based  

1. Make cell C10 active and ensure its format in Excel is General. Right-click and select Format 
Cells… Click on category General and hit Ok.  

2. In C10, enter the =DESC formula, referencing the appropriate cells for each parameter 
[=DESC(Account, Company)]. Press Enter and recalculate this cell (F2 + Enter). If the description 
is not returned ensure that your formula is correct i.e. =DESC(B10, B2). 

3. Give the parameters in this formula the correct absolute and relative cell referencing. The DESC 
function should now be defined as: =DESC($B10, $B$2). 

4. Copy the formula down using Auto-Fill so that it covers all accounts. Ensure that you entered the 
correct absolute and relative cell referencing and recalculate the current sheet (Shift +F9). 

5. Save the workbook file. 

The F9 report now recalculates dynamically and contains formulas to return period balances and account 
descriptions. If you look at tab: Trial Balance 2, you can compare the formulas F9 created automatically 
from F9 Table with Output as Formulas – they should look identical. 

 

Report Creation with GL Paste 

F9 can generate a properly formatted GL function easily for you via the Inquire and GL Paste command. 
GL Paste is useful if you need to create reports with specific segment filters or groupings such as by 
Segment1 as well as a good first step to creating your own formatted report with the most flexibility. 
 
GL Paste creates the first GL formula in a new worksheet along with all required parameters properly 
referenced with the correct absolute and relative cell referencing.  

1. Click on the Sheet 1 Tab and rename this sheet to: GL Paste. 
2. If the F9 Table task pane is displayed, close this first. 
3. From the F9 ribbon, choose Inquire and GL Paste. This will open the F9 Inquire task pane. 
4. For settings, set to: 

Company:   -1 
Type:  BUDGET1 
Year:    2004 
Segment1: type * 
Segment2:   type 2* 
Segment3:   type * 
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5. Next, select Get Balance to review the total for accounts *-2*-*: 

 

6. Next, we will paste F9 formulas to the active worksheet. Set the active cell to A1 as GL Paste will 
start at the current active cell. 

7. From the F9 Inquire tab, click the GL Paste button. You will see the beginnings of a new report 
with F9 report dropdown controls, a GL formula properly parameterized and also a DESC formula 
written to return account descriptions. 

       

8. Place your cell pointer on the period January. Notice it is also a F9 dropdown control and 
contains many of the typical period specifiers F9 recognizes. Drag this control across to 2 more 
columns –the month automatically changes for you and the dropdown control is also retained.  

 

9. Select the cell with the account description and notice a =DESC( ) was written. 
10. Select the cell with the GL amount. Change the name of the F9 formula to =NGL to have F9 

return the amount as a positive amount. Notice this GL formula contains one additional 
enhancement, the F9 BSPEC( ) function which stands for Build Specifier. 
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11. BSPEC is used to separate the full account into separate segments to be filtered in your F9 
reports. For example, you may need to return balances for a list of Segments as opposed to just 
one or all. BSPEC makes combining segment groupings and filters easy. An example will 
illustrate this further: 

a) Go to cell B2 and select Segment1 000. Hit F9 to recalculate and note a new amount 
returned. 

b) Go to cell B3 and instead of selecting from the dropdown, type for its value: ‘00,01. 
Ignore the warning by Excel by clicking Ok. Hit F9 to recalculate again.  

c) Set the active cell to the period amount returned and select Drilldown from the F9 
Ribbon. Select different Drill By criteria and hit the Drill button to view the different 
results. Click on any cell in Excel to return to the report. 

12. Next, we will expand the report created by GL Paste by adding more rows.  

 

Lists 

The primary role of the Lists feature is to save time manually entering data that already exists in your GL. 
The List feature typically allows you to enumerate:  

• Segments (used most often) 
• Companies 
• Budgets 
• Lists 
• Periods 
• Years 

1. From the F9 Ribbon, click on Lists:  
2. Select Segments under Available Lists. 

• In the List Segment drop-down, select Account 
• In the Where drop-down, select Account 
• In the Is field, type 2*  

3. Ensure Generate Descriptions is unchecked 
4. Click Send To Clipboard, press OK to the List was Sent To Clipboard message, and Quit the Lists 

window. 
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Next, we will want to paste this into the sheet and finish the report. 

1. Select the cell that contains your first account number (Cell A10) and select Paste (Edit | Paste). 
This will paste in all Accounts within the range. 

2. Click on the GL formula in E10 and drag it to the other columns F10 and G10.  
3. Next click on the cell with the description, D10 and highlight cells:  D10 to G10.  
4. Using your mouse, drag the selection down rows with accounts.  
5. Hit F9 to recalculate the new results. 
6. Auto-Fit the description column if necessary to expand its width for display and save the report. 

      
 
You can use the features of Excel and F9 to make this report exactly how you wish. Add sum formulas, 
change single account specifiers to ranges, add a variance column to compare the current year versus 
the past year, make graphs and charts. These are all benefits of creating your financial reports with F9 
directly within a spreadsheet application as powerful as Excel. 
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F9 Report Wizard  

Report Wizard is available to step users through defining report dimensions such as: rows, columns, and 
the control area, and writes a fully completed F9 report with dropdown controls and F9 formulas for you.  

Select or change any of the dropdown controls to calculate new results easily. The initial report can be 
expanded upon since F9 formulas are written with the correct cell referencing for all parameters. 

Create an Actual versus Budget Report: 

1. Select Sheet 2 as the active worksheet and close the Inquire task pane, if open. 

2. From the F9 Ribbon, select Report Wizard:  
3. Resize the Report Wizard task pane to increase its display by dragging its border on the left 

towards the active worksheet. 
4. Pick -1 for Company and hit next. 
5. For the Row axis, select Account in the upper window. Next, highlight all accounts that start with 

411 and hit the >> button to move to the selected window.  
6. Select Total and >>. Hit Next. 
7. For the Column axis: select Periods in the upper window. Select Description and >> to move to 

the selected window. For Periods, select This Month and >> and then This Month Budget and >>. 
Select Variance and >>. Hit Next. 

8. For the remaining axis, select Year 2004, Type BUDGET1 and type in value * for both the 
Segment1 and Segment3. Hit Next. 

9. Under Format, enter a title such as: Actual vs. Budget Report. 
10. Select checkbox to reverse the sign, 
11. Choose the conditional formatting output and Finish. 
12. Use Auto-fit to resize the columns. 

 

      
 
 
       
Rename the tab to: Report Wizard and save the report. 
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F9 Sales Report with Filtering  

The next example will create a F9 report in the form of a dynamic Excel Table with filtering. Tables in  
Excel 2007 and 2010 offer many new advantages including dynamic formatting, formulas, filtering of one 
or more columns to collapse and expand information, as well conditional formatting and KPIs. 

F9 Table creates financial table reports for enhanced analysis and business intelligence. 

1. From the F9 Table Report task pane, select the F9 Table tab. 
a. For the Account, type: 41* and other segments: *.  
b. For Period select: January, Type BUDGET1, Year 2004 

2. Select the Options tab and change: 
a. F9 Chart: Include Account segments, check Segments in Separate Column 
b. Output: unselect Classic Chart, Paste as GL Formulas 
c. Formatting:  Add Data Bar, Table style: Light 11 (green) 

3. Click on the Find button at the bottom of the F9 Table task pane to see the results output in a 
new worksheet.  

 
 
Notice the amounts are negative – this can be quickly changed by going to the first cell with an amount 
and editing the formula.  
 

1. Go to cell F11.  
2. Hit the F2 key to edit the formula. 
3. Change =GL to =NGL and hit Enter. 

 
All formulas below the first in the F9 table are automatically changed. This is one of the advantages of 
Tables in that Excel provides extra intelligence to manage its own content.  
 
Filtering: 
 
Notice there are a number of rows with all zeros. Within Tables, one can filter on different criteria over one 
or more columns very easily.  
 

1. In column F, select the down arrow at the cell that displays its heading, January. 
2. Uncheck the last item for zero values (0) 
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Note a filter icon displays to the right of January to indicate a filter is active for this column. 
 

 
. 
Another filter might be to display certain Segments. Click on the dropdown for Segment3 and select just 
Segment 01. The report will now display the subset requested. 
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Rename the tab to Sales Report and save the workbook. 

Because the contents of the table report contains F9 formulas, the financial information returned is 
dynamic and you can select or change the F9 control area and recalculate for new reports. In addition, it 
is possible to expand on the table with new columns for additional periods, for example.  

Custom filters can be created to track values or results for a specific business need. Experiment with F9 
Table to view different types of results and explore more into the new functionality for Excel 2010 and/or 
Excel 2007 Tables. 
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F9 Pivot Table Report  

The next example will create an F9 report in the form of a dynamic Excel pivot table. Pivot Tables in Excel 
2007 and 2010 offer many new advantages including dynamic formatting, formulas, filtering of one or 
more columns to collapse and expand information, as well conditional formatting and KPIs. 

F9 Pivot Table Report creates financial pivot table reports for enhanced analysis and business 
intelligence. 

1. From the F9 Pivot task pane, select the Source tab – this tab basically describes what data to 
populate the Pivot table with. 

a. For Years check both 2004 and 2005. 
b. For the Account, type: 4*, and other segments: *.  
c. For Period select: January 

 

 

2. Select the Options tab – this is used to provide more detail on how the Pivot table content will be 
managed: 

a. Check Segments in Separate Columns 
b. In the Create supporting amounts as: dropdown select NGL Formulas 
c. Check: AutoFit Pivot Table Columns 
d. Check: Recalc/Refresh in Manual 
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3. Click on the Create Pivot Table button at the bottom of the F9 Pivot task pane to have an initial 
Pivot Table report generated.  

4. To calculate values, click anywhere inside the Pivot report and then right-mouse click and select 
Refresh. 

5. The results should look similar to:  
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6. Note amounts are shown broken down by Year. To showcase some of the capabilities of the pivot 
table, move filters to different areas using the provided PivotTable Field List task pane. For 
example, drag Years to Report Filter, Segment1  to Row Labels and Segment3 to the Columns 
area: 

              

7. The report will display as:  
 

 
 
 

8. Select different Years and refresh the table for results to change. Note that you also have filters 
available to you on both the rows and columns to display totals, for example, for certain 
Segments. 
 

9. Another feature with Pivot tables is drill. Select a cell with an amount and either double-click or 
right-mouse and select Show Details. The details that total this amount are shown in a newly 
created tab. 
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Experiment with F9 Pivot Table to view different types of results and explore more into the new 
functionality for Excel pivot tables. 

 

Congratulations - this completes the F9 Quick Tour!  
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Appendix A:  F9 Parameters and Syntax 
Period Specifiers 

In F9, the Period specifier is used to identify the period or periods for which you are requesting account 
balances and uses logical, plain-English terms. 

Period Specifier 
Examples Description 

Month 1 The first period of the fiscal year 
This Month, Month The current (usually open) period 
This Month Last 
Year The current period in the previous year 

Last Month The period before the current period 
Total for the year including the current period (applies only to P/L accounts as BS 
accounts are returned as a cumulative balance by default) Year to Date, YTD 

Period 2 activity (applies only to BS as P/L accounts are returned as transactional 
values by default) Change Month 2 

September The balance for September 
Quarter 1, QTR 1 Total for the first quarter 

 
You may notice that your Balance Sheet accounts have the same value for a consecutive number of 
periods (current period and all future periods). F9, following the principles of accounting, returns Balance 
Sheet accounts as a cumulative balance. P/L accounts are returned as a monthly change value. 

Account Ranges 

In most financial reports you will want to return values for a range or series of accounts in one cell.  
 
For example, to return a value for all of your cash accounts (a Natural Account code of 1000 through 
1090), you would specify a range of accounts that includes all cash accounts. Let's assume that you have 
a three-segment account code where the first segment of your account code is the Department, the 
second is the Natural Account and the third is the Sub-Account. In this example, the Account specifier 
would be *-1000..1090-*. This would return the value for all accounts between 1000 and 1090 for all 
Departments and all Sub-Accounts. As you can see Wildcards (the asterisk) can be used in specifying 
ranges of accounts with F9. 
  

Account 
Specifier Description Example Result 

Returns all accounts, all Segmets. 
*-*-*   

Matches any character, or set 
of characters regardless of 
length. 

  Returns the 000 Segment1 for all Segment2 
in the 00 Segment3. *  000-*-00  

    
4*-5131-00 Returns all accounts that start with a 4 for 

Segment2 5131 and Segment3 00. 
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25 

? Matches a single character in 
the exact position. 4?0-5131-00

Returns all accounts that have a first 
character of 4 and third character of 0 for 
Segment2 5131and Segment3 00. 

.. Indicates a range of account 
segment values 400..500-*-* 

Returns all accounts from 400 up to and 
including 500 for all Segment2 and all 
Segment3. 

, 
Creates a list of account 
specifiers or account 
segments. 

400-5100-
00,500-*-* 

Returns a balance for the sum of account 
400-5100-00 and 500 with all Segment2 and 
all Segment3. 

**Please note that for most ranges of accounts to work, you must have Return Zero For Account Match 
Not Found selected in F9 Setup.  
 
Although these Account specifiers may seem to be able to accommodate every aspect of your reporting 
needs, imagine if you wanted to create a departmentalized report for each department. Using the above 
Account ranges will accomplish this, but you will have to recreate the report for each department, 
reentering the appropriate account ranges, each time specifying a different department.  
 
A very important feature of F9 is allowing you to cell reference each segment of your account code 
individually, so that you can make your report turn on any segment of your account code. This is 
accomplished with the BSPEC Function. 

BSPEC 

The BSPEC function expands the functionality of the Account specifier by Building the Account 
SPECifiers from cell references. The BSPEC is really just the Account parameter in any F9 formula that 
uses an Account parameter. The Syntax of the BSPEC is: 
  
=BSPEC(Segment 1, Segment 2, Segment 3) 
Where:  

Segment 1 is a cell reference to the first segment of your account 
Segment 2 is a cell reference to the second segment of your account 
Segment 3 is a cell reference to the third segment of your account 

 
There can be as many Segments as your account contains. 
  
The GL formula with the BSPEC function will look as follows: 
 =GL(BSPEC(Segment 1, Segment 2, Segment 3), Period, Company, Year, Type) 
 
In any F9 formula that references an account number, the BSPEC can also be a cell reference. The 
easiest way to learn the BSPEC function is to see it in use. Refer to the steps under GL Paste within this 
Quick Tour as a good example. 
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